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Introduction:
MICROSOFT WORD is a word processing software. It is the
most popular and most commonly used program in the
world. It is a product of the company called MICROSOFT
which also makes the WINDOWS operating system. It is
packed with numerous features for document creation and
formatting. It also allows the use of graphics and tables in its
documents.
1. Opening Word
Press windows key, then go to programs submenu and then
select Microsoft word by using down arrow or the letter M
repeatedly. In some computers Microsoft Word could be
inside Microsoft Office sub menu as it is a part of larger
package called MS Office
Press Enter, Word will open and you will get the message
Microsoft Word Document 1 Edit
2. The Word Screen
Like all applications in Windows the program window of MS
Word contains the Title bar at the top followed by the Menu
bar, the toolbars, one or more toolbar, formatting bar, the
document window and the status bar at the bottom. There
also could be ruler bar below the formatting bar.
This complete program window can appear in any of three
sizes on the screen
Restore: It covers 2/3rd part of the screen
Maximize: It covers the complete screen except the area of
the task bar.
Minimize: It appears as an icon in the taskbar
It is important to note that the taskbar is always visible
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2.1 Application Menu: Pressing Alt and spacebar together
gives Application control menu, which has the abovementioned options for selecting the size of the window.
Press enter on the option you want. The option that is
currently applied is dimmed. Jaws announces this item as
grade. Grade means that, particular item is currently not
available for execution.
2.2 Title Bar: The TITLE BAR appears at the top of the
window and it contains the name of the document followed
by the name of the program. At the right hand corner of the
bar there are three buttons: Minimize, Maximize/Restore and
Close button.
The Menu Bar: Like all applications running under windows
environment WORD has a menu bar which has a complete
list of what can be done in this application. Menus are lists of
available commands. This is a horizontal bar situated just
below the title bar. It has the following items written on it
from left to right.
FILE EDIT VIEW INSERT FORMAT TOOLS TABLE HELP
Each of these items have a menu which drops down when
they are clicked or activated.
The ALT key is used to access the menu bar. On pressing
ALT the PC cursor (the selection cursor) goes to the menu
bar and highlights the first item which is FILE. The RIGHT
and LEFT ARROW keys are used to move between the
different menu bar items.
The DOWN ARROW should be pressed on the menu item to
unfold its drop down menu which will have various
commands. The UP and DOWN ARROW keys are used to
select any particular command. Some of these commands
may have a sub menu of their own which can be opened by
pressing ENTER or the RIGHT ARROW key.
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3. The menu bar: Some of items may have three dots or
ellipsis. This indicates that this command has a dialog box
associated with it which will open when this command is
activated. To activate any command given in the menu select
it and press ENTER. There is an alternative short cut way of
accessing and activating menu items. Every item both on the
menu bar and in the drop down menu has one letter in its
name underlined which is also called HOT KEY. This HOT
KEY can be pressed to activate that item. For example the
menu bar item FORMAT has the letter O underlined.
Therefore to open the format menu two methods can be
used. Either press ALT to activate the menu bar and then
use the RIGHT ARROW to move to FORMAT and then
press DOWN ARROW to open the drop down menu or,
press ALT to activate the menu bar and then press the letter
O to open the drop down menu directly. It is important to
remember that the hot keys function within respective
menus, for example if you are inside FILE menu and then
you press the letter O, the OPEN command on this menu will
be activated as its hot key is also O.
4.Toolbars: It contains graphics of frequently used
commands for use by the mouse. Toolbar items are available
in the menu bar. Press the Alt key to activate the menu bar.
The Ctrl tab key at this stage take you to the various tool bar.
Use left or right arrow keys for navigation within a toolbar.
5.The Document Window: This window covers the largest
part of the program window and display the active
documents. It is important to note that any number of
document windows can be opened although each window
may not be fully visible and only one window is active. The
document window is the child window of the main MSWORD window. The issued commands or keystrokes affect
only the active document windows.
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Status Bar
It is in the form of a thin horizontal strip at the bottom of the
program window
It shows your present position in the document. It is read
using Insert plus page down if the screen reader being used
is Jaws.
It contains information about current page number line,
section etc. a typical message will look like:
Page 4 Sec 1 4/23 At 3.3” Ln 7 Col 5
This conveys the following message about the position of the
insertion pointer in the document.
Page 4: This is the page number of the document.
Sec 1: The pointer is in section one of the document. Note
that sections are used to divide a document into several
parts to facilitate different type of formatting of each part.
4/23: This indicates that you are on page four and there are
twenty-three pages in total in this document.
At 3.3”: This indicates that the pointer is 3.3 inches below the
top edge of the page.
Ln 7: You are on seventh line of the current page.
Remember that lines are counted for each page only.
Col 5: The insertion pointer is on fifth column. The first
character of the line is taken as the first column and so forth.
6. Exiting Word
Press ALT to activate the menu bar, press down arrow on
the file menu and then select EXIT and press ENTER.
Alternatively use Alt plus F4 to close Word
If you have made some changes Word asks you whether you
want to save the changes or not.
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Press ENTER on YES or NO as the case may be.

7.

Creating a New Document
Press enter on New in the file menu. A dialog box opens with
different options for the type of document that you want to
create. These options are arranged on different TAB PAGES.
Select BLANK DOCUMENT from GENERAL page if you want
to create a simple document.
Control plus N can also be used alternatively. By using the Ctrl
N key the document typed dialog box will not appear and
immediately after pressing Ctrl N a new blank document is
open.
The new documents that are opened have temporary names
like DOCUMENT 1, DOCUMENT 2 etc in the order of their
creation.

8.

Entering Text
It is done through the alpha numeric keys on the key board
The text gets inserted to the left of where Insertion pointer is
positioned on the screen. The pointer keeps moving towards
the right as more and more text is inserted. The insertion
pointer can be identified as a blinking I-beam shape on the
document window. If it is not blinking then no text can be
inserted.

9.

Saving a Document
First decide a file name and location that is in which drive
and/or folder you want to save this file
Select SAVE AS.. from FILE menu and press ENTER.
Alternatively do Control plus S. A dialog box opens. Other is
another option of save in the file menu. When a document is
being saved for the first time either of them can be used. But
when a existing document needs to be saved with a different
name, different format or at a different location then only
SAVE AS.. can be used. Using SAVE.. on a document which
has already been saved at one location saves the document
at the same location along with the changes made in it. The
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Ctrl S key activates SAVE AS.. command when saving the file
for the first time, it activates the SAVE.. command if the
document is being saved again.
The SAVE AS dialog boxes has following fields.
File name: Type the file name you had decided.
Save as type: This is a COMBO BOX having options of
different formats in which the document can be saved. Every
application program uses a specific format to save information
in the memory disks and this is also indicated by extensions in
file names. MS WORD saves its own files in the DOC format
and therefore the files carry .DOC extension. However it also
allows files to be converted into several other formats like RTF
(Rich text format), TXT (Text), HTM (Web page) etc.
Save in combo box: Select the drive using up and down arrow
keys and press enter
List view: Select the folder in which you want to save and
press enter
Finally press enter on SAVE button.
10. Closing a Document:
Go to file menu and press ENTER on CLOSE or alternatively
use control plus F4 to close the document, which is active.
11. Opening an Existing Document
An existing document is nothing but a file which is on a
storage medium hard disk, floppy or CD. It has a name and
definite location.
Do Control plus O or press Enter on Open in File menu.
The Open dialog box opens. It is similar to save dialog box.
It has similar fields namely File name, Look in and List view.
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Press Enter on OPEN after selecting the file from the list
view or typing the file name along with the full path in the
file name edit box.
12. Working With Multiple Documents
1

2

The list of all open documents is available in the WINDOW
menu. The active document has CHECKED marked after it.
To switch to a different document press ENTER on its
name
in the menu.
Use Control plus F6 to move between open documents.
Use this command repeatedly to switch between all open
documents.
13. Navigation and reading commands
The following are the commands for navigation in a
document:
Move One Character Left
Move One Character Right
Move One Word Left
Move One Word Right
ARROW
Move to Beginning of Line
Move to End of Line
Move One Paragraph Up
Move One Paragraph Down
ARROW
Move to Beginning of Document
Move to End of Document
Scroll Up or Down One Screen
DOWN

LEFT ARROW
RIGHT ARROW
CTRL+LEFT ARROW
CTRL+RIGHT
HOME
END
CTRL+UP ARROW
CTRL+DOWN
CTRL+HOME
CTRL+END
PAGE UP or PAGE
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14. Changing the Document View
In the view menu there are different options for display of the
document.
14.1 Normal: A section of the page appears on the screen.
The margins are not visible. This option is used generally while
creating documents. The page breaks appear as dotted line.

14.2 Page layout: Shows the page, as it will appear after
printing with the margins on all four sides of the page. The
page breaks are clearly evident.
14.3 Outline: Shows the structure of the document and is
helpful while developing the contents of the document. It is
easy to drag portions of the document from one place to
another in the document.
14.4 Document Map: It shows the main headings of the
document in a vertical pane which opens on the left side of the
document window. It is useful for directly moving to any part of
the document and for keeping a check on your position in the
document.
14.5 Zoom: It is used to increase the size of the text for better
visibility. It doesn’t affect the size of the characters on printing.
15. Correcting and Deleting Text
Backspace and Delete key are used for deleting text.
BACKSPACE deletes the character to the left of the insertion
pointer whereas DELETE key erases the character on which
the pointer is present that is to the right of the pointer. For
example if the pointer is placed on the letter O of the word
'continent' the backspace key would erase the character C and
the delete key would erase the letter O. The backspace key is
normally used to erase the wrongly entered text at the time of
typing.
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Control plus Delete deletes the whole word if you are at the
beginning of the word.
CONTROL + BACKSPACE deletes the previous word.
16

Cutting, Copying, and Pasting Text

16.1 Selecting Text: First you need to select the text. Shift key
is used with the navigation commands to select the desired
portion of the text. For example the command for moving one
word right is Ctrl Right Arrow. The command for selecting a
word is Ctrl Shift + Right Arrow. Similarly, command for
moving to the end of the current line is END KEY and the
command to select from the text from the current position to
the end of the line is Shift + End. Many actions can be
performed on this selected text like converting the case of a
text, making a text bold, underline or italics.
16.2Copying selecting text to the clipboard: The selected text
can be copied onto the clipboard by using the copy command
provided in the Edit Menu. The clipboard is the portion of the
memory where the text is stored temporarily. The text inside
the clipboard is removed immediately when the new text is
written on to it.
16.3 Moving to the place where selected text is needed to be
copied: This step is accomplished using the normal navigation
commands.
16.4 Pasting the text from the clipboard: This is done using the
paste command which is listed in the Edit Menu. The text
which was send to the clipboard by using the copy command
is now copied onto the new place in the document.
16.5 The Cut Command: The cut command can be used
instead of the copy command. If the copy command is used
then the text remains as it is at the place from where it is
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copied. Thus the text from its original place is not erased.
When the cut command is used instead of the copy
command, the text from its original place is erased. The Paste
Command, however, brings the text back at the position of the
insertion pointer. Thus if we use the cut command, the text is
moved and if we use the copy command the text is copied.
Note: The accelerator key for copy is Ctrl C, Cut is Ctrl X and
Paste is Ctrl V.
17. Using the Undo/Redo/Repeat Commands: UNDO &
REDO commands are in the EDIT menu.
17.1 Undo (Control plus Z) cancels the last command. It is
very useful when a wrong command is given by mistake. If 5
commands were issued the first undo command would cancel
the fifth command, the second undo command would cancel
the fourth command and so on.
17.2 Redo (Control plus Y) repeats the last command. It is
often used to save typing effort. However, if the redo
command is used after one or more undo commands, the
redo commands cancels the effects of these undo commands.
18. Inserting Bookmarks
Bookmarks are used for remembering a location in the
document. WORD places an electronic mark at the point in
the document you want. This mark is later useful for reaching
to that particular point in the document.
Place your insertion pointer where you want to insert the
bookmark.
18.1 Press Enter on Bookmark.. which is in the INSERT
menu.
18.2 It will ask you for a name. Give any name you want to
this bookmark and press Enter on ADD BUTTON.
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18.3The bookmark will be inserted at that point in the file and
its name will appear in the bookmark name combo box of the
Go to dialog box besides this dialog box.
18.4 The bookmark dialog box has DELETE BUTTON and GO
TO BUTTON which can be used for removing the bookmark
and going to that bookmark in the file respectively.
19. Using the Find/Replace/Go to Commands
19.1 Find feature is used to search particular string of
characters, special characters or specific formatting in the
document. This command appears in the EDIT menu. Control
plus F is the accelerator key.
On giving this command a dialog box opens. It has an edit box
for typing the text you want to search in the document.
When you want to find occurrence of particular text in the
document you type the text in the edit field and then press
ENTER on FIND NEXT button. Word searches the document
for that text and it places the insertion pointer where it finds the
text for the first time in the document.
Press Escape to close this dialog box. Read the current line it
will have the desired text. If you want to find out if the text is
appearing again in the document then repeat the above
process. This time the pointer will be placed at the second
occurrence of the text in the file. The Ctrl Page Down key and
the Ctrl Page Up key can be used to search the next or the
previous occurrence of the word searched once.
19.2 If any text with a particular type of formatting that is font or
paragraph formatting is to be found in the document then press the
MORE button in the dialog box. This dialog box will now contain more
fields including FORMAT BUTTON MENU and SPECIAL BUTTON
MENU. These buttons can be used to define the special character or
formatting that you want to search.
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19.3 REPLACE is a feature of MS WORD for searching a
particular text in a document and replacing the same with the
specified text. The Replace command is in the EDIT menu and
Ctrl plus H is the short cut command. In the FIND WHAT edit
area of the dialog box type the text you want to remove. In
REPLACE WITH edit box type the new text. Press the find next
button to reach to the first occurrence of the word to be
replaced. At this juncture:
• The find next button can be used to leave the word as it is
and jump on to the next occurrence of the word.
• The change button can be used to replace the current word
and jump to the next occurrence of the word.
• Change all button can be used to replace all the occurrence
of the word in the document.
19.4 Special characters and formatting can also be replaced by
using the MORE buttons and then selecting the desired option
from the FORMAT and SPECIAL BUTTON MENU.
19.5 Go to command is used to go to a particular location in the
document. The GO TO command is in the EDIT menu and the
accelerator key is CONTROL plus G.
A dialog box opens which has a field named GO TO WHAT and
it is a list box. This list has various options which can be used for
going to a particular place in the document. The options are:
PAGE,
SECTION,
LINE,
BOOKMARK,
COMMENT,
FOOTNOTE, ENDNOTE, FIELD, TABLE, GRAPHIC, OBJECT
and HEADING.

The next field is an EDIT box. Select the option which you want
to use from the GO TO WHAT list box and then enter the
relevant information in the edit box. For example if you select
PAGE, you will be prompted to enter the page number and if the
option selected is BOOKMARK, you will be asked to enter the
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name of the bookmark in the edit box which now becomes an
EDIT COMBO field and also displays the names of all existing
20. Using Auto text: This feature is aimed at saving the effort
of typing frequently occurring text. AUTO TEXT provides a
ready-made list of standard phrases used for reference line,
salutation, header/footer, mailing instructions etc. For creating
auto text entry:
Type the text as you want with formatting
Select the text
Go to the pull down menu of the Insert.
Go to the submenu of Auto Text.
Select new and press enter.
Computer will prompt for an abbreviation for this text. Type in
the abbreviation in the Edit Box.
The next time you need this text just type the abbreviation and
press F3.
The original text will get reproduced.
A list of all AUTO TEXT created are displayed in the NORMAL
submenu which is inside AUTO TEXT sub menu. Pressing
ENTER on any entry also produces the attached text on the
document.
21. About Character Formatting:
It refers to changing the appearance of the characters.
Characters include all alphabets, all numbers, punctuation
marks etc. Character formatting includes size, styles, colour of
the characters. A set of all characters of a particular
appearance is called FONT. There are numerous fonts that can
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be used on the computer. TIMES NEW ROMAN, ARIEL,
UNIVERSE, GARAMOND, COURIER are some of the popular
fonts. The default font in MS WORD is TIMES NEW ROMAN
but it can be replaced with a font of your choice. The size of
the characters is measured in POINTS. 72 POINTS are equal
to 1 INCH, therefore, 1 POINT is equal to 1/72 of an INCH. The
normal font size in office communication is 12 points.
a)

Changing the Font, Font Size, and Other Formats: Select
the text you want to format. Press enter on FONT.. which
is in FORMAT menu. Alternatively press CONTROL + D.
The font dialog box opens. It has the following fields.
i) Font type: There is a list of all the fonts installed on the
computer. This is an EDIT COMBO box, therefore, the
desired font can either be selected by using the arrow
keys or by typing its name in this field.
ii) Font style: It has choices regular, Bold, italics and bold
italics.
iii) Font size: Select sizes 8 to 72 using the ARROW KEYS.
A size which does not appear in the combo box can be
directly typed over here. WORD allows font sizes 1 to
1638.
iv) Font Color: Select a color using arrow keys and press
Enter.
v) Underline style: There are various choices for how text
should be underlined. The default setting is for single line
and it is the style normally used. The other options
available are DOTTED LINE, WAVY LINE, DOUBLE
LINE, WORDS ONLY and THICK LINE.
vi) Strike through and double strike through check boxes:
This is used for striking out or cutting out one option. For
example if somewhere it is written Father/Husbands
name and you want to strike out Husbands name then
select this word and check the check box using spacebar
and do OK. Note that striking out text is different from
deleting it. When strike out the text does appear on the
screen but crossed with a line.
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vii)

Superscript: Text written slightly above the normal level
is called superscript. For example in case of 1st ST
should be superscript. To do this select st and check this
checkbox and do OK.
viii) Subscript: Text written slightly below the normal level is
called subscript as in case of H2O. To make 2 subscript
select 2 and check this check box.
ix) Shadow Check Box: It adds a shadow beneath and
behind the text.
x)
Outline Check Box: It displays the inner and outer border
of the selected text.
xi) Embossed Check Box: Makes the text appear raised of
the page.
xii) Engraved Check Box: Makes the text appear as if
pressed into the page.
xiii) Small Caps Check Box: It formats all selected lower case
letters as capital letters and reduces their size. It does
not effect the numbers, upper case letters and
punctuation marks.
xiv) All Caps Check Box: This option formats selected lower
case letters as upper case letters but it does not effect
their size.
xv) Hidden Check Box: It prevents selected text from being
displayed or printed. If subsequently needed the text can
be displayed and printed by checking the HIDDEN check
box on the VIEW and PRINT tab pages of the OPTIONS
dialog box respectively. The OPTIONS dialog box opens
from the TOOLS menu.
xvi) Default Button: After making appropriate choices of
FONT, STYLE, SIZE CHARACTER, SPACING & TEXT
EFFECTS in the dialog box. The appearance of the font
can be set as default by activating this button.
xvii) OK & CANCEL button: These buttons are used to apply
or cancel the effects of the changes made in the dialog
box respectively.
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b)

Changing character spacing and text effects: The FONT
dialog box has three TAB PAGES: FONT, CHARACTER
SPACING & TEXT EFFECTS. FONT page has already
been explained above. The CHARACTER SPACING
page has options which allow control on the following:
i) Spaces between characters
ii) Horizontal compression or expansion of text
iii) Change in vertical positioning of text viz. raised, normal
or bottom
iv) KERNING which automatically adjusts the spaces
acquired by slim and broad characters (for example tw)
so that each character takes the same space on the
page.
v) TEXT EFFECTS page has a combo box from where an
animation style for the selected text can be chosen.
The effect of animation is seen on the screen only and it
is not printed.
C) Copying, Pasting, and Removing Text Format: Select
the text whose formatting you want to copy and apply it
to another text. Press Shift plus Control plus C to copy
the format. Now select the text on which you want to
apply this formatting. Press Shift plus Control plus V to
paste this format.

23 Paragraphs Formatting:
It refers to changing the appearance of the paragraphs as
a whole. It includes indents, line spacing, paragraph
spacing and page breaks.
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For doing all this you have to go to Paragraph dialog box,
which is in the Format menu. This dialog box has the
following fields.
23.1. Alignment: This refers to horizontal positioning of the
Para. It has options left, right, and center and justified.
When a paragraph is justified the lengths of all lines are
made equal by adjusting the spacing between words as far
as possible. It is advisable to use this option at the start of
paragraph formatting.
23.2. Left: Type the margin that you want to leave on the left
side of the paragraph. This is called left indent.
23.3. Right: Type the margin in inches, which you want to leave
on the right side of the paragraph. This is the right indent
for the paragraph.
23.4. Special: This combo box has three options that is none,
first line and hanging. In first line indenting the first line of the
paragraph shifts to the right side by the distance, which you
mention in the next field, which is By: edit. When you
choose hanging the first line of the paragraph remains the
same and rest of the lines shift to the right side by the
distance which you mention in By: edit.
23.5. Before and After: These are for leaving specified amount
of space before and after the selected paragraph. Choose
the margin which is in points by using the arrow keys.
24.6. Line spacing: It is for changing the spacing between
two lines. By default it is single line but it can be increased to
requirement. Select using down arrow. If you want it to be
more than double then select Multiple and type the spacing
in the next edit box.
23.7. Do O K after you have completed the options. It is
important to note that the changes will effect the selected
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paragraphs and if nothing is selected it will effect the typing
which you will do now on.
24 Setting Tab Stops:
When Tab key is pressed, the Insertion pointer moves to
the right by a certain distance. In fact, the insertion pointer
jumps to the next tab stop by default the tab stops are set
at every half-inch. The tab stops can be removed. They
can also be created at the desired locations within the line
width. This feature is used for creating tables by aligning
the text within the column. This can be done using the
following steps:
♦ Decide how many columns you want to create and what
will be their width. If three columns are required then two
Tab stop settings have to be done.
♦ Go into Format menu and press Enter on Tabs.. This
dialog box has the following fields
Tab stop edit combo: Type the width or distance that you
had decided for the first stop. Remember that the distance
is always calculated from the left edge of the paper.
Default tab stop: Generally this is 0.5 inches that is even
when you don’t do any tab setting by yourself the pointer
moves by this distance on pressing the tab key.
Alignment radio button: When you come to this field it will
speak one of the following: Left, right, center, decimal or bar.
If you want the text to be typed on the right of the tab stop
then keep it left aligned. When the tab stop is right aligned
the text appears to the left of this tab stop. If a column
contains decimal numbers then make the tab stop of this
column decimal aligned. In such a case the decimals will be
aligned one below another. Center alignment means that
the text will be distributed equally on both sides of the tab
stop. If it is bar aligned then a vertical bar will appear at the
tab stop. Choose the option using up or down arrow.
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Leader tab: You will get the following options by using up for
down arrow. None, dot, dash, underline. When tab is
pressed the pointer jumps to the right and leaves blank
space in between if none option is selected. Dots, dashes or
a straight line will fill the blank space when the relevant
option is selected.
Set button: Press enter on this button after choosing options
for each tab stop.
Clear all button: It removes all tab settings in the document.
OK button: Press Enter finally.
25. Creating Numbered and Bulleted Lists
It is used for giving numbers or bullets to items in a list.
It is in the Format menu.. Bullets and numbering dialog box
has three Tab pages namely bullets tab, number tab and
outline number. On all these three pages there are eight
options or formats for selection. These choices are in the
form of buttons and are arranged in two rows and four
columns. Use the arrow keys to choose any button.
Bullets: It has choices of symbols, which can be placed
before points.
Number tab page: It has options like 1 2 3, a b c, a) b) c) etc
Outline Number: It has options for sub points.
Special Considerations: In the Auto Correct item given
under tools menu opens the multiple page dialog box. One
of the pages in this dialog box is Auto Correct As You
Type. If the check box of Automatic Bulleted List and
Automatic Numbered List are checked the following will
happen:

23

♦ If any line starts with a digit then the pressing of enter
key will bring the next number automatically in the next
line. The automatic numbering feature switches on
automatically.
♦ If any line starts with a dash or star the bulleted list
command gets activated automatically.
If an already typed line is needed to be given a number, the
procedure for that would be: to place a pointer at the
beginning of the line. Go into the bullet and numbering
dialog box from the format menu. Select the numbered tab
page. Select the numbering scheme and press enter. The
new number for the item is inserted at the location of the
cursor.
The numbering provided to the items can be of 9 levels. The
numbering in this document is also provided using this
feature. The main topic numbers are of level 1 whereas the
sub-points within each topic are of level 2. Any sub-points of
the level 2 items would be assigned level 3 numbering. If the
Auto Numbering feature is on you get a new number by
pressing the enter key. At this stage press the tab key to
increment the level number by 1. Use the shift tab key to
decrease the level number by 1.
26. About Page Set-up:
It refers to setting of margins and choosing paper size etc.
Press Enter on Page set-up in the file menu. A dialog box
opens which has four tab pages. The following two pages
are relevant:
Margins tab: Type the margins in the various edit boxes
which include left margin, right margin, top margin and
bottom margin. Gutter margin refers to the binding margin.
The binding margin is the space which is left blank on the
left-hand side on the odd pages and on the right hand side
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on the even number pages. This is useful for double side
printing.
The margins can be written in inches, cms, or points. For
expressing the margins in inches type the number followed
by a double quote sign. For typing the margins in the
centimeter type the number followed by cm. To type the
margins in point type in the number followed by the letter pt.
You might recall that there are 72 pts in an inch.
There is a combo box for choosing where you want to apply
these settings. Choose whole document or this point forward
as the requirement may be.
Paper size: Choose from the standard sizes that are
available in the combo box or type the width and height in
the edit boxes. Choose how you want to print that is portrait
for lengthwise or landscape for width wise printing.
27. Columns:
Text can be written in more than one columns in a page. In
magazines or newspapers the text is written in columns.
The text we are referring here is the running text. Do the
following to create a multiple column document:
Activate column command from the format menu. A
dialogue box will open.
Selecting number of columns: Focus is on edit spin box.
Choose number of columns you wish to create.
Column width and space between columns: These are two
edit boxes. Default width is suggested. Type in new value
to change the suggested width and space between two
columns.
Equal column width: This is a check box. If checked, it will
automatically assign column width to the columns.
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Pre-set column styles: There is a set of 5 radio buttons.
These correspond to the five types of column styles:
¾ Style one doesn’t have any column definitions. User can
choose column width and number of columns of his/her
own choice.
¾ Style 2 has predefined two columns with equal width.
¾ Style 3has predefined three columns with equal width.
¾ Style 4 has predefined two columns. Width of the left
column is much less than the right side column.
¾ Style 5 also has two predefined columns. Width of left side
column is much larger than the right side column.
Apply to: This is a combo box. The column settings can be
applied to whole document or from current cursor position.
The column settings can also be applied to the selected
text. Select the text before entering this dialogue box. Only
then the option of applying column settings to selected text
will be available.
Activate the OK button after making appropriate entries in
the dialogue box.

Navigation in columns:
You can know the current column number by pressing
Insert tab key. If you have made two columns in five rows,
the first line of the second column is treated as line 6. You
can get this information from the status bar.
To move to the next column do the following:
Go to the last line and last character of the current column.
Press the right arrow key. To go to the previous column,
go to the first line and first character of the current column.
Press the left arrow key.
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Command for reading the current line reads line with in the
current column. How ever, in JAWS, when the jaws cursor
is active, command for reading current line reads
corresponding line of all the columns. You can move the
jaws cursor to the text of any column in the current line.
Pressing left click will bring the insertion pointer to the
position of the jaws cursor. This is another way of moving
from one column to another.
28. Inserting Date and Time:
Current date and time can be inserted in any document
without typing. It gets inserted at the point where the
pointer is present. Press Enter on date and time, which is
in the Insert menu. A dialog box opens which has a combo
box showing available formats. Choose the format you like
using arrow keys and press Enter. The date and time get
inserted.
29. Giving passwords to files:
Files can be given two types of passwords to protect them
from unauthorized use.
Password to open: A person who does not have the
password will not be able to open or read the file.
Password to modify: Without the password a person can
read the file but can’t make changes.

To give password:
♦ Press enter on options in the tools menu. A dialog box
opens.
♦ It has number of tab pages.
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♦
♦
♦
♦

Go to the SAVE tab page in this dialog box.
Reach the password edit box in this page.
Type the password and press enter.
You will be asked to type the password again. Press
enter after typing it again.
♦ Remember to save the changes at the time of closing the
file.
At the time of opening the file password will be asked. If a
wrong password is given the file will not open. If you don’t
have the password but you are getting a read only button
on pressing tab then press enter here the file will open in
read only mode.

Password for preventing modification to a document
•
•
•
•

Open the document.
On the File menu, click Save As.
Click Options.
In the Password to modify box, type a password, and then
click OK.
• In the Reenter password to modify box, type the password
again, and then click OK.
• Click Save.
Tip: If you're writing a document for review, you can allow
others to make suggestions by using comments or tracked
changes but still leave the document protected from other
modifications. Click Protect Document on the Tools menu,
and then click Tracked Changes. To let reviewers insert
comments but not change the contents of the document,
click Comments.
30. Checking the Spelling in a Document
Word has a built in dictionary. When spell check command
is given it compares the words in the document with the
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words in the dictionary. If it does not find a match it refers to
it as a mistake and gives similar words as suggestions for
correcting the spelling.
To start the spell-checker activates the spelling and
grammar command from the tools menu. The accelerator
key for the same is F7. The spell check dialog box opens
and it tells you the first wrong spelling it detects.
This dialog box has the following fields:
♦ Edit Box showing the mistake: Displays the wrong
spelling along with the sentence. The cursor remains on
the wrong word when the dialog box opens.
♦ Suggestions list box: Shows a list of one or more
suggestions for the wrong word.
♦ Ignore and Ignore All Button: If you think the word is
correct and you wish to leave the word as it is then use
either of these two buttons to continue checking the rest
of the document. The difference between the Ignore and
Ignore All are is that the Ignore button ignores the
occurrence of that word only for the currently pointed out
mistake. However, if you select the Ignore All the spell
checker would not point out the same mistake in whole of
the document.
♦ Change and Change All Button: When a mistake is
shown in the edit box and you find an appropriate
suggestion in the list box then use the Change and
Change All Button to replace the misspelled word with
the correct suggestion. The Change All button would
make the change wherever this misspelled word occurs.
Sometimes appropriate suggestions do not appear in the
suggestions list box or no suggestions are displayed at
all. In such cases go to edit box and use the arrow and
editing keys to correct the mistake and use the Change
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and Change All button to change their misspelled word in
the document with the edited version of the word.
♦ Add Button: Use this button to add frequently occurring
words into the dictionary. These words will not be
considered as mistakes afterwards. Words like names of
persons or cities will be shown, as spelling errors using
Add Button would save the trouble of ignoring such
mistakes forever.
You will get a message when the check is complete.
Press enter then.
31. Using the Thesaurus:
This feature is useful when you want to check the
meanings of words or replace words with better alternative
words. Place the insertion pointer on the word and then
press shift plus F7. A dialog box opens having the
following important fields:
Meanings list box: Shows list of meanings for the selected
word.
Replace with synonym list box: Displays a set of simonizes
for each meaning. Any of these words can be used to
replace the word in the file.
Replace button: After selecting the word in the synonym list
activate this button for changing the word in the document
with this new word.
32. Printing a Document:
Press Enter on Print... in the File menu or use Control plus
P. The dialog box has the following relevant fields:
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Number of copies: Type in the desired number of copies of
the document required to be printed.
Print: All pages in range is what you will hear. This combo
box is useful when you want to print on both sides of the
paper. First select odd pages and print them. Then put the
printed papers back into the printer with their sides reversed.
Now select even pages in this combo box and print.
Print Range Radio Button: You can select one of all the
following options:
♦ All: It prints all the pages of the document.
♦ Current Page: Prints only one page in which the insertion
pointer is located in the document.
♦ Page Range: Prints the specified page numbers.
Print Range Edit Box: This edit box is useful only if the Print
Range Radio Box is selected in the previous control. This
edit box is used to specify the page numbers to be printed.
For example type 5 - 8 to print from page 5 to page 8. Type
5, 8 to print page 5 and page 8.
Selection: If a portion of the text is to be printed then select
it. In the print range radio button you will now find one more
option that is selection radio button. This should be used for
printing selected text.
33. Inserting Headers and footers
Select Header and Footer from the View menu and press
Enter.
The view changes to Print Layout and displays the header
area. A Header and Footer Toolbar also appear on the
screen at this point of time. Write the header directly over
here.
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Press down Arrow to display the footer area and now type
the desired footer. If the header is more than one line than
pressing down arrow after reaching the last line of the
header will take the control to the footer area.
The text written in header and footer area can be formatted
in the same way as other text in Ms Word.
Now this view needs to be closed. The closed button
appears at the bottom right corner of this view. You can
either click on this button using the Jaws cursor or press
the Alt C to activate this button.
34. Auto Correct:
As you type you will realize that there are some mistakes
that are made quite often. MS Word provides the AUTO
CORRECT feature for automatically correcting such
mistakes. You can make certain auto correct entries so that
word automatically corrects spelling errors. To create Auto
Correct entries do the following:
Select the wrongly spelt word.
From the tools menu, choose auto correct.
In the replace box type your correct word.
Press the add button.
The entry is added to the list of auto correct entries.
Click on ok to return to the document.
From then
same way
dialog box
correct two

on every time this word is misspelled in the
MS Word would automatically correct it. The
of the auto correct has five check boxes -initial capitals, capitalize first letter of sentence,
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capitalize names of days, correct accidental usage of caps
lock key, replace text as you type. These check boxes
should be kept checked.
♦ Correct Two Initial Capitals - If the first two letters of a
word are typed in an upper case then the send letter is
changed to the lower case.
♦ Correct Accidental Usage of Caps Lock Key - By
mistake if you have left the caps lock key on and you
type a word with its first letter using the shift key. In such
a case the result would be that first letter of the word
would be in lower case and rest of the letter in a word
would appear in an upper case. This check box would
automatically correct such mistake. In this correction the
case of each of the letter in the sentence would be
reversed.
35. Creating tables in word:
A spreadsheet type of table can be created in a word
document. The grid of columns and rows can be created.
Go to the TABLE menu and select table from INSERT
submenu and press ENTER.
A dialog box opens. Mention the number of rows and
columns that you want. The other options need not be
changed in normal case. A table gets inserted where the
insertion pointer was present.
Use TAB to move between the columns and UP and
DOWN arrows to move between rows and write the text.
Use the DELETE submenu in the TABLE menu to remove
rows or columns and INSERT submenu to insert rows and
columns.
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Use the SELECT submenu to select table, rows or
columns. This is essential before formatting. Remember
that the text in the table is formatted through the FORMAT
menu of Word only like other text.
AUTO FIT TO CONTENTS command inside the AUTO FIT
submenu is very useful for changing the size of the table.
This command adjusts the width of the column according
to the number of characters entered in the data. This
command is available from word 2000 onwards.
36. Converting text to table:
Text if written in a particular way can be converted into
tables. While writing the text a separator like DASH, TAB
or COMMA should be used between the entries of different
columns. At the end of every row use the enter key. Now
select the entire text which needs to convert into table.
Activate the TEXT TO TABLE from the TABLE menu. In
the dialog box that opens mention the separator that you
have used. Also check the number of columns. On doing
OK the text is changed to table.
37. Mail Merge
What is Mail Merge?
Imagine a situation where you have to send one letter to 75
different persons. MS-Word has a feature called Mail
Merge to avoid the typing of this letter 75 times. In Mail
Merge merging happens between two documents. The first
document is the body of the letter and the second
document contains names and addresses of those 75
persons.
In the body of the letter special codes are placed at the
places where names and addresses are to appear. On
issuing the merge command, MS-Word prints this body of
the letter 75 times. Each time new name and the address
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is picked up from the list of names and addresses. To
create the two documents and to take merged print outs do
the following:
 Go to the LETTERS AND MAILINGS, which is present in
the Tools Menu and Enter on it to get its Submenu.
 Select the MAIL MERGE WIZARD & press Enter or
Click on it.
This will open the “Mail Merge” Task Pane. This Task
Pane is divided into three parts. First part is for creating
or editing main document, the second part is for the data
source and the third one is to merge the documents.

Select document type
 Now you are in the first part I.e. “SELECT DOCUMENT
TYPE”. Select any one of the following option using up
or down arrow key and press TAB if using keyboard;
mouse user can click.
The options in this pane are as follows:
Letter, E-mail messages, Envelopes, Labels, Directory

Select starting document


Press Enter or Click on “Next: Starting document” link.
This will open the “Select starting document” list with
the following options:
¾ Use the current document: This will use the open and
active document in the mail merge process.
¾ Start from a template: To use the pre set document or
template.
If you select this option, press TAB and Enter or Click
on “Select template”, you will get a dialog box with
different Tab pages having various type of templates.
¾ Start from existing document: Select this option if you
want to use already saved file then press TAB till

35

“Open” and enter on it you will get the open dialog box,
which is as same as available in the “File Menu”.
Select any file and press TAB.

Select recipients
 Press Enter or Click on “Next: Select recipient”, which
will open the “Select recipients” list having three options
which will determine the manner to connect the
recipients list with the main document which is open
and active.
Options are as follows:
¾ Use an existing list: Select this option to use names and
addresses from a file or a database which has been
already created. Then presses TAB, you will get the
“Browse” button. Press Enter or Click on it, it will open
the Open dialog box which is as same as available in
the File Menu.
¾ Select from Outlook contact: Select this option to select
a name and address from an Outlook contacts folder.
Then press TAB. You will get the “choose contacts
folder” link and press Enter or Click on it. A “Choose
profile” dialog box will appear then follow the given
instructions.
¾ Type a new list: Select this option to type the names
and addresses of recipients. then press TAB, you will
be on the “Create” link press Enter or Click on it which
will open a “New Address List” dialog box then follow
the

Instructions.
Note: In all the above cases when you are successful in
linking your data file with mail merge process; a “Mail
Merge Recipients” dialog box appears automatically which
shows the list of recipients, or records with all the fields.
Here press ENTER or click on OK button.
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Write your letter
Go to the “Next: Write your letter” link. Press Enter or Click
on it. Now press F6 to switch over to main document. This
can also be be done by Clicking on main document.
Position the cursor where you want to insert the field from
“Recipient List”. Then again switchover to the Task Pane.
Enter or Click on “More items, or Press ALT+SHIFT+F” to
get the “Insert Merge Field” dialog box. Select a suitable
field and press Enter or Click on insert or OK button to
insert the selected field. Press ENTER on CLOSE button
or click on it to close this dialog box. Repeat this process
till you have inserted all desired information in the letter.
Normally number of repetition is equal to the number of
fields.

Preview your letter
After the above process is complete, press ENTER or
Click on “Next: Preview your letter”. It is a link text which
will open this topic and provide tools to preview your
merged letter with the following options. Select and press
ENTER to activate any option:
¾
¾
¾
¾

¾

<< (less less) : To preview the previous letter.
>> (greater greater): To preview the next letter.
Find a recipient: Press ENTER or Click on it. A “Find
Entry” dialog box will appear. Follow the instruction.
Edit recipient list: This option provides a “Mail Merge
Recipients” dialog box having a list of recipients and
buttons. It provides the opportunity to edit recipient
list.
Exclude this recipient: This option excludes that
recipient which has been selected or is being
previewed. It will not appear in the new document
which you will get after the Mail Merge process is
complete. .
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Complete to merge
 Press Enter or Click on “Next: Complete the merge”
link which opens the “Complete the merge” list. Now
Mail Merge is ready to produce your letters .It has
following options:
¾ Print: It will print the letters directly without displaying
the merged document.
¾ Edit individual letters: It will merge the letters into a new
document. Press Enter or Click on this option to display
the Merge to new document dialog box. Follow the
instructions & press Enter or Click on OK button.
Accelerator key for this option is ALT+SHIFT+N. A new
document containing merged letters is displayed.
38. Create a table of contents:
The table of contents is a very useful feature of MS-Word.
This not only provides an overview of the contents of the
full documents but also allows jumping to the section
indicated by an entry in the table of contents. There are
several ways of creating table of contents. The methods
described here are outline and heading style method.
Follow the given steps:
38.1 Layout Line Method:
If you have used the numbering feature described in
section 25 of this document. You can create a table of
contents where each of the number and the text appearing
on that line along with the page number will appear on the
table of contents.
Apply the numberings of the appropriate levels to the
headings and sub-headings which need to be listed in the
table of contents.
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Activate the Index and Table command from the Insert
Menu. In Word 2000 and XP this command is in the submenu of Reference. The Reference is in the sub-menu of
Insert. This command will open a dialog box which has
four tab pages. Go to the Table of Contents tab page.
Format List Box: There are several formats of displaying
Table of Contents entries "From Template" option is
almost similar to what we see in the books. Select the
desired format from this list.
Show page numbers and Right align page numbers: Both
of these are check boxes.
Show Levels: It is an edit spin box. Specify the number of
levels which you wish to include in the Table of Contents.
Tab Leader: It is a combo box. Select the character which
would fill up the blank space in the line between the
heading and page number of the Table of Contents entry.
Press enter on the OK button. This would create the Table
of Contents at the location of the insertion pointer. If the
Table of Contents needed to be created at the beginning
of the document make sure to go to the beginning of the
document before activating the Index and Table
command.
Heading Style: Instead of using the outline numbering you
can apply styles to headings that you need to include in
the Table of Contents. For doing this:
Select the heading and activate the Style command from
the Format Menu.
From the list of styles choose heading 1 for level 1,
heading 2 for level 2 and so on.
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Activate the OK button.
Repeat steps from 39.2.1 to 39.2.3 for marking headings
with appropriate heading styles.
Activate the Index and Table command from the Insert
Menu and follow the steps described in 39.1.1 to 39.1.7.
39. Using macros to automate tasks

What is a macro?
If you perform a task repeatedly in Word, you can
automate the task by using a macro. A macro is a series
of keystrokes, word commands and instructions that you
group together as a single command to accomplish a task
automatically. Instead of manually performing a series of
time-consuming, repetitive actions in Word, you can create
and run a single macro — in effect, a custom command —
that accomplishes the task for you. Here are some typical
uses for macros:
•
•

•
•

To speed up routine editing and formatting or typing like
address of your own organization.
To combine multiple commands: for example, inserting a
table with a specific size and borders, and with a specific
number of rows and columns.
To make an option in a dialog box more accessible.
To automate a complex series of tasks.

Word offers two ways for you to create a macro: the macro
recorder and the Visual Basic Editor.

Recording a macro
The macro recorder can help you get started creating
macros. Word records a macro as a series of word
commands in Visual Basic for Applications. When you record
a macro, you can use the mouse to select commands and
options, but the macro recorder doesn't record mouse
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movements in a document window. For example, you can't
use the mouse to move the insertion point or to select, copy,
or move items by selecting or dragging. You must use the
keyboard to record these actions. When you're recording a
macro, you can temporarily pause recording and then resume
recording where you stopped.
For quick access to your macro, you can assign it to a
toolbar, a menu, or shortcut keys. Running the macro is as
simple as selecting the toolbar button or menu command or
pressing the shortcut keys. You can also use the Macros
command (Tools menu, Macro submenu) to run a macro.
Perform the following steps:
Activate the Macro command from the Tools Menu. A submenu will appear. Activate the Record command from this
sub-menu. A dialog box opens.
Macro Name: This is an edit box where a name for this macro
is to be typed. Do not use spaces in the macro name.
Assign Macro to a keystroke: A button labeled keyboard
appears in the dialog box. Activate this button to assign
keystroke to this macro. Refer to the section 39.7 for details
for the dialog box for assigning keystrokes.
Assigning a Macro to a toolbar symbol: A symbol in the tool
bar can be inserted to run this macro. Activate the tool bar
button to assign a symbol to this macro.
Macro Location: This is a combo box which has the options of
normal. dot or the current document. If the macro is saved in
the normal. dot or the normal template then the macro will be
available in all MS-Word document being created using the
normal template. The second option would make the macro
available only in the document where it is stored.
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Description of the Macro: It is an edit box where you can type
in the helpful hints about why this macro is being created.
The keyboard assignment dialog box: If you activate the
keyboard button a new dialog box appears. In the edit box for
keyboard shortcut type the key combination like Alt Ctrl D.
This combination would activate the macro. Go to the assign
button and press enter. Go to the OK button and press enter.
You are now back to the document window.
What ever you type or whatever commands you give at this
stage will be recorded in the macro. It means when this
macro will be activated all the keystrokes will be executed in
the same sequence as are been done now. Pause and stop
recording buttons are available at the bottom of this
document window. The stop recording command is also
available in the Tools Menu under the Macro command.
Run Macro: Activate the Macros command in the Macro submenu under tools. In the Macro name box, select the name of
the macro you want to run. If the macro doesn't appear in the
list, select a different document, template, or list in the Macros
in box. Activate Run. The macro can also be executed using
the keystroke or the toolbar button if you have assigned it
while recording the macro.
Delete a macro: On the Tools menu, point to Macro, and then
select Macros. In the Macro name box, select the name of the
macro you want to delete. If the macro doesn't appear in the
list, select a different document, template, or list in the Macros
in box. Select Delete.

